\ 2 Turn on the printer.

©

Turn on the Mac.

4 Place the Setup Software & User’s
Guide CD-ROM in the CD-ROM drive.

anea /S CANON.B|

o 5 Double-click the Mac OS X folder, then
ca ca = double-click the Printer Driver folder.

Mac 05§ Mac 05X Manual

0
- )

ana L PINMA (PADOOR

Double-click PIXMA iP4000R xxx.pkg.

» . g
“x” represents a number.

= Note

When using Mac OS X v.10.2, the Authenticate dialog
. ol - box appears. Enter the administrator’s name and
password, and click OK.

7 Click Continue.

o Il 0 e 8 Read the License Agreement carefully

- e — and click Continue, then click Agree.

P O CANON SOFTWARE LICENSE AGREEMENT
MPORTANT-READ THIS AGREEMENT BEFORE INSTALLING THE
SOFTWARE FOR BUBBLE-JET PRINTER. BY INSTALLING THE
SOFTWARE FOR BUBBLE-JET FRINTER, YOU ARE DEEMED TO
AGREE TD BE BOUND BY THIS AGREEMENT.
Tres legal document s a icense agreemen between you nd
Canon Inc{"Canon™).
BY INSTALLING THE SOFTWARE FOR BUBBLE-JET PRINTER (THE
“SOFTWARE™), YOU ARE DEEMED TO AGREE TO BE BOUND BY

4 THE TERMS OF THIS AGREEMENT. F YOU D0 NOT AGREE TO
| THE TERMS OF THS AGREEMENT, [0 NOT INSTALL THE
i SOFTWARE AND PROVPTLY RETLRN THE CANON DISK T0 THE
\PLACE WHERE YOU DBTANED T FOR A REFLIND BEFORE THEY
ARE LSED.
[ consderaiiénan the rifn 1 use the SOFTWAFE, you agres =

P ae)  Cans

‘eon bt g e © 8 Select a destination to where you want

Select a Destination

E S G i 5 ] e to install the printer driver, and click
® Introdwetion softmare. .
Continue.

@ Setatt Destinasion r=th
T ! A |

J

— 10 Click Install.

| 5.508 (2.7E Free)

/ iitaling chis safware reguires 32.2MB of additional 1pace. When using Mac OS X v.1 02’ 20 to Step 12.

| Yeu hur iiscied 1o
P “Maciemosh KD

E=
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—_— 11 Enter the administrator’s name and

o password, and click OK.
G )
‘ .( """" : ) = Note
3 =0 ) If you have forgotten the administrator name and/or
password, click @ and follow the instructions in Mac
Help.
LT — T 12 A message asking for your confirmation
e, o el to restart your Mac appears on the
o veame PR - screen. Read the message, then click
ot | cancel ({7 Comtinue mvtatiaren ) . .
- Continue Installation.
\ Software installation will start.
eon i e 13 Click Restart.
Install Software
E
o e When the computer restarts, BJ Network Tool will start
Pl up. If it does not start automatically, select Library -
o Bl . oo v swccesstully nstadied Printers - Canon - BJ Printer - Utilities - BJ Network
L) Tool.
: _ 14 Select Setup from the pop-up menu.
| W
:
L 15 Click Printer Setup Utility (Print
Tatup gl
s Center on Mac OS X v.10.2).

My plan B0 connect 3 printer with & USE cabd
st up for a netwark, click [Prisses Secup Lsiley

16 Click Cancel.
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L)
-]
. ]

: o 17 Confirm that your printer is added to the
, B9¥ X .9 list of printers.

Ci = PADOOR (00.00 Canan iPAGO0R

i

The alphanumeric string after the printer name is its
MAC address.

= Note

If the printer does not appear on the list, click Add and
select USB from the pop-up menu. Select iP4000R
from the list of printers and click Add.

Printer driver setup is now complete.

0

eoe S omous 18 Install applications. In the Setup

3 3 " | Software & User’s Guide CD-ROM,

s s double-click CANON_BJ and then
double-click Application.

Double-click the installer in folder for each application
you want to install.

19 Perform print head alignment before
you start using your printer.

See “Aligning the Print Head - Macintosh” on page 53.

Setting Up an Additional Computer to Use a Printer Already
Connected to a Network

When your printer is already set up to be used over a network, and you want to set up another computer to
use the shared printer, the computer needs to be set up to use the printer, but not the printer itself. Follow
these steps.

B Setting Up an Additional Computer to Use a Printer Already
Connected to a Network - Windows

= Notes
* Make sure the computer you are setting up is NOT connected to the printer via a USB cable.
* Make sure the printer is properly set up and is currently available for use over the wireless or wired
network.
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Turn on the printer.

Turn on the computer.

Place the Setup Software & User’s
Guide CD-ROM in the CD-ROM drive.

= Notes

* If the CD-ROM does not run automatically, click
Start and select My Computer, then double-click
the CD-ROM icon. For non-XP Windows, double-
click My Computer in the Windows screen, then
double-click the CD-ROM icon.

« If the language selection screen appears, select the
language, then click OK.

« If the location selection message appears, select
your place of residence, then click Next.

Follow the instructions displayed on
screen. When the screen shown on the
left is displayed, click Easy Install.

= Note

When you select Easy Install, the items included in the
CD-ROM are installed automatically. To select
particular items to install, click Custom Install and
follow the instruction on the screen.

5 When the list of applications to install

appears, verify the contents, click
Install, then follow the instructions on
the screen.



bl ared e o ke e ncat s ba g0

=)=

| T charge et rame, clck Fhet Port Hame)

g Pieiebodd  Canen PR FHOR

ek frmh]

P Mama: Canon PO PHE0R

ot CHRINP_OENE

Sl Port Hame.

=

Read the License Agreement carefully
and click Yes.

Select Set up only the computer and
click Next.

Select the printer in the Printers dialog
box, and click Next.

= Notes

If the printer was not detected, confirm the following

and click Update.

* Ensure that the printer is on.

* Ensure that the firewall is turned off.

* When using wireless LAN, confirm that the
computer can communicate with the access point.

* When using wired LAN, confirm that the
computer is connected to the hub.

 Confirm that the printer is not set to use access
control.

Click Finish in the Setup Completion
dialog box.

To change the port name, click Set Port Name. For
details, see “Changing the port name” in
“Troubleshooting” on page 81.

Setup will next install application programs.
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10 When the installation results are
h'ﬂ_;__":’" - displayed, click OK.

e If you are prompted to restart the computer, click Yes
and restart the computer.

11 When the On-Screen Manual dialog
box appears, click Next.

Printer software installation is now complete. You can
skip print head alignment if it is already adjusted

properly.

B Setting Up an Additional Computer to Use a Printer Already
Connected to a Network - Macintosh

= Notes

* Make sure the computer you are setting up is NOT connected to the printer via a USB cable.
» Make sure the printer is properly set up and is currently available for use over the wireless or wired
network.

-

Turn on the printer.
\ 2 Turn on the Mac.

3 Place the Setup Software & User’s
Guide CD-ROM in the CD-ROM drive.
> /%J /
LYY oy o 4 Double-click the Mac OS X folder, then
¥ | ¥ a double-click the Printer Driver folder.
eoe o 5 Double-click PIXMA iP4000R xxx.pkg.

g,

X" represents a number.

= Note

When using Mac OS X v.10.2, the Authenticate dialog
box appears. Enter the administrator’s name and
password, and click OK.
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6 Click Continue.

enn U e e 7 Read the License Agreement carefully

Saftware License Agreement . . .
- B and click Continue, then click Agree.
:, ::::‘"ﬂ" CANCN SOFTYWARE LICENSE AGEEEMENT

AMPORTANT-FEAD THIS AGREEMENT BEFORE INSTALLING THE
SOFTWARE FOR BUBBLE-JET PRITER. BY INSTALLING THE
SOFTWARE FR BUBBLE-JET FRINTER, YOU ARE DEEVED TO
AGREE T BE BOUND Y THS AGREEMENT.

Thvs legal document is 3 cense agreement between you and

Canon inc.{"Canen”).

1 BY INSTALLING THE SOFTWARE FOR BUBBLE- T PRINTER (THE
/ “SOFTWARE"), YOU ARE DEEMED TO AGREE T BE BOLND BY

THE TERMS OF THS AGREEMENT. F YOU DO NOT AGREE TO
THE TERMS OF THS AGREEMENT, DO NOT INSTALL THE
SOFTWARE AND PROMPTLY FETLRN THE CANON CRSK T THE
PLACE WHERE TOU DBTANMED [T FOR & REFLIND BEFORE THEY
ARE LSED.
QL considecation s the righn 15 une the SOFTWARE, you agres v

—

lsan e - 8 Selecta destination volume to install the
Select a Destination . . . -
- T ey i printer driver, and click Continue.
o Rarodection software,
| @ 9 Click Install.

® il —
Maciniosh HD

308 270k i) When using Mac OS X v.10.2, go to step 11.

/ Imsaling this software regeires 12,208 of asdinonad 1pace.
Yeu turee SE1H 1 ieial By softmare o9 th velumas
“Maciemosh KD

Go Back Contn

.

s 10 Enter the administrator’s name and
s password, and click OK.

(N s D)
Qo ) = Note
® o) If you have forgotten the administrator name and/or

password, click (?) and follow the instructions in Mac
Help.

non It e - 11 A message asking for your confirmation
- = to restart your Mac appears on the
ks o 0 bnstall the softwars naw?

sig| - NE screen. Read the message, then click
onmiy e (G ) Continue Installation.

Software installation will start.
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an Install B prister driver

Install Software

© introduetion
o Licgnse

© Sebeet Destination
 Inatafistion Type

© inatalling The software was successfully installed

 Finish Up

Click Restars o finish installing the seftware

o
1yt plir 1o eannect & printer with & USH €abile or use & prinber that bus bren
set up for a netwark, click [Prister Secup Uailay] and add the peinter.

Cancel

Cancel Setup

n Wb TR s ] T

Printer Livt (=]
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12 Click Restart.

When the computer restarts, BJ Network Tool will start
up. If it does not start automatically, select Library -
Printers - Canon - BJ Printer - Utilities - BJ Network
Tool.

13 Select Setup from the pop-up menu.

14 \When a message appears notifying that
no printer was detected, click OK.

15 Click Printer Setup Utility (Print
Center on Mac OS X v.10.2).

16 Click Cancel.

17 Click Add.

18 Select CANON BJ Network from the
pop-up menu, select iP4000R from the
list of printers, and click Add.

19 Confirm that your printer is added to the
list of printers.

The alphanumeric string after the printer name is its
MAC address.

Printer driver setup is now complete.



eoe Somous o 20 Install applications. In the Setup
¥ | ¥ | " Software & User’s Guide CD-ROM,
v osx o double-click CANON_BJ and then
double-click Application.

Double-click the installer in folder for each application
you want to install.

Software setup is now complete. You can skip print head
alignment if it is already adjusted properly.

Aligning the Print Head

Aligning the print head allows you to print without shifting the color registration, and is a necessary step to
print properly.

= Notes

* The Print Head can be aligned also from the printer itself. With the printer on, load a sheet of
Letter-sized plain paper in the Sheet Feeder. Hold the RESUME/CANCEL button until the
POWER lamp flashes four times.

* You need to load a sheet of A4 or Letter-sized plain paper in the Sheet Feeder when you carry out
the print head alignment.

B Aligning the Print Head - Windows

1 Click Start and select Control Panel,
Printers and Other Hardware, and
then Printers and Faxes.

= Note

For non-Windows XP users, click Start, then select
Settings, Printers.

2 Click the icon for your printer.
Open the File menu and select:

* Windows XP/Windows 2000 —
i Printing Preferences
: * Windows Me/Windows 98 — Properties

to open the setting screen.
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4 Click the Maintenance tab, and click
Print Head Alignment.

& Cason PIXMA §4000F Properiles

5 Read the message and click Print Head
Alignment.

Sty subormaticaly head shgreeare

ot ol loac v it o Ak e 170 plan e i st bt an cck
Furt Head tigrere
Toscamy out marusal s st clch. Carvcel
P, chck Castors Sainge o fas M amtanunce tab of o peinke dhiver, chack iigr,
P maruaaly, and ek Saed Then iy agar.

Tisprind ar chock, o cumerd sei. cheh Choch Seti

(i) wssows | _conct | e

It takes about 80 seconds to start printing. Do not open
the Top Cover while printing.

6 If a message warning you not to

) e o e et perform other operations appears, click
OK.
7 Ensure the pattern shown on the left is
printed.

The Print Head is aligned automatically. The printer is
now ready to use.

= Notes
E E E E E - - « If the pattern is not printed successfully, refer to
- e Em e oEm o Em “Eleven Flashes” in “The Power Lamp Flashes
— Orange” of the User § Guide.
o o ot * At first-time setup, if you are prompted to restart
- the computer, click Yes to restart the computer.
- = . ] N . .
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B Aligning the Print Head - Macintosh

1

‘an &L Prinses Uil - PA000R 1 5

& | Mozzle Check
a3 patem that lets you check whethes print
Bead nozzies are clogged.
ot Head Algaant
I weill align the print heads 1 comect any erred in
Sheir installation position.

Frimt Head Algnmens

ead alignment, clack [Cancell, N

ICancal], Next, chacl
[Align heads massally] in the Custom Settings panel, and click
fsend]. Then try again.

Ta prink and check the curment setting, click [Check Setting].

Double-click the hard disk icon where
the printer driver was installed, the
Applications folder, and then the
Utilities folder.

Double-click the Printer Setup Utility
icon.

When using Mac OS X v.10.2, double-click the Print
Center icon.

Select your printer from the Name list
and click Utility.

If the printer is not displayed in the Printer List, you
need to add it on the list.

For details, follow the instructions in Mac Help.

When using Mac OS X v.10.2, select your printer from
the Name list and click Configure.

Select your printer from the Product list
and click Maintenance.

BJ Printer Utility appears.

Select Test Print from the pop-up
menu, and click Print Head Alignment.

Read the message and click Print Head
Alignment.

It takes about 80 seconds to start printing. Do not open
the Top Cover while printing.

53



54

7 Ensure that the pattern on the left is
printed.

The Print Head is aligned automatically. The printer is
now ready to use.

= Note
If the pattern is not printed successfully, refer to

“Eleven Flashes” in “The Power Lamp Flashes
Orange” of the User 5§ Guide.




Basic Operations

+ Ifyou detect smoke, unusual smells or strange noises around the printer, immediately switch the
printer off and always unplug the printer. Contact your local Canon service representative.
* To avoid injury, never put your hand or fingers inside the printer while it is printing.

Printing with Windows

Adjusting the print settings according to your needs allows you to produce better quality prints.
In this section, we will use NotePad for the purpose of explanation. The procedures and the screens that
appear on your computer may differ depending on the application that you use.

B Printing

I Document - Notepad
N Edit Format  ‘iew Help

Hew Chri+hl
Open... ko
Save s

Save fs...

Page Setup...

Exit.

& Printieg Prefesences

T) MedaTise Pl Pt

Lp)| eemsome  [FamFeessen

@ Man | i PageSehe | B SumpBachgound | of Etec | 5§ Proie: | B Manierarce

1 Print the document from the application.

From the File menu, click Print.
Refer to the application’s users manual for the actual
procedures.

Ensure that your printer is selected,
then click:

* Windows XP — Preferences
» Windows Me/Windows 98 — Properties
* Windows 2000 — Main tab

Specify the required settings and click
OK.

= Notes

« If you use anything other than plain paper, see
“Basic Printing Settings” on page 57.

« This section describes the procedure for selecting
the paper source with the Paper Feed Switch on
the printer. For details about the other settings for
specifying the paper source, refer to “Changing
the Paper Source” on the User 5 Guide.
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4 Ensure that the proper lamp of the
paper source is lit.

SheetFeeder ) )
Lamp If not, press the Paper Feed Switch on the printer.

Cassette 5 To start printing, click Print.
Lamp

Printing will start in a few moments.
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B Basic Printing Settings

For the best print quality, specify the minimum requirement settings in the Main tab. To get the
best results, ensure you select the type of media loaded in the printer when printing on paper other

than plain paper.

2 Printing Preferences @lgl (7)
&) Main |£2 Page Setup | @ Stamp/Background | # Effects | (3 Profies | fif Mantenance
MedaTupe:  ([Plan Paper o — (1)
Paper Source (Papel Feed Swich v } @)
Print Quaity: O High D
| ® stendard
o —®
O Dialt
O Custom

\___/ \L

Color Adjustrment @ Auto
(] Gl Pining (o Manual “)
Plain Paper —
[ Grayscale Pinting
| DlPrvientefozpinig ) 5)
[ FuntOpors. | [ Aot | [ Defads |
o J[Ccaed ([(He J}——(6)

AN

(1) Media Type

Select the type of media loaded in the printer.

(2) Paper Source

Select the setting here when you do not specify the paper source with
the Paper Feed Switch on the printer.

(3) Print Quality

Select one option from High, Standard, and Draft. Select Custom to
set the print quality manually.

(4) Color Adjustment

To control the color adjustment settings in more detail, select Manual.

(5) Preview before printing

Select this to check the layout before printing.

(6) Help

Click this for a more detailed explanation of the functions in the tab.
(This may not appear when using Windows XP or Windows 2000. If
this happens, click Start then select All Programs (or Programs) -
Canon PIXMA iP4000R - Guide.)

nz

Click this to change the cursor shape to ?. By clicking on the item’s
name with this ? cursor, an explanation will be displayed.

= Notes

* Clicking Print Advisor allows you to change to the most appropriate print settings simply by
answering questions when prompted.

+ Use the application to specify the paper size and paper orientation. Before printing, open the
settings screen and check that Page Size in the Page Setup tab is the same as that specified within

application.

* Refer to the User s Guide for more information about printer driver functionality.
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Printing with Macintosh

Adjusting the print settings according to your needs allows you to produce better quality prints.

B Printing

" @ Teaedi JEI edin Formar Window Help =

New =N
Open... =0
Open Recent »
Close =W
Save =5
Save As... oRS
Save All

Revert to Saved

Page Setup... OXP

Print... =p

Page Setup
Settings: | Page Attributes o

ot or. [ Pan00R =
Canan [P4000R

Pupur Sze: [ Ad n
2100 m x 29.70 cm

ovemarion: 81 [1| 13

Scale | 100 %

" @ Temedin TN Edt Formar Window Help =

New N
Open... =0
Open Recent >
Close =W
Save =5
Save As... oS
Save All

Revert to Saved

Page Setup... OGXP

Printer: | iP40DOR

Frasacs: | Standard 1
Cophes & Pages )
Copees: [} i Callated
Pages. @ Al
From: 1 L
AT Rl Py | SEAY PO e S

(=)

Q
=

Sheet Feeder
Lamp

Q

I~

Cassette
Lamp
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Open the Page Setup dialog box in
your application.

From the File menu, click Page Setup. Refer to the
application’s users manual for the actual procedures.

Specify the page setup, then click OK.

For details, see “Page Setup” on page 59.

Open the Print dialog box in your
application to print the document.

From the File menu, click Print. Refer to the
application’s users manual for the actual procedures.

Specify the printing settings according
to your requirements.

For details, see “Basic Printing Settings” on page 59.

Ensure that the proper lamp of the
paper source is lit.

If not, press the Paper Feed Switch on the printer.

Click Print.

Printing will start in a few moments.



B Page Setup

From the Page Setup dialog box, specify the Paper Size settings.

Page Setup
Settings: | Page Attributes ]
Format for: [ iP4D0OR ]

Canon iP4000R

Crapersize: (ma )}——— Select the paper size

TO0Ucm X 29.70 cm to be used.
Orientation:
Scale: |100 &
@ (Canee)

B Basic Printing Settings

For the best print quality, specify the minimum requirement settings in the Print dialog box. Select
Quality & Media from the pop-up menu to change the display of the dialog box. To get the best results,
ensure you select the type of media loaded in the printer when printing on paper other than plain paper.

Print

Printer: | iP4000R %)
Presets: | Standard )
Quality & Media | ]

]

@edia Type "Plain Paper

G’aper Source : | Paper Feed Switch ™ ])7 (2)

Paper Allocation

Print Mode : () Printing a top-quality photo
C Printing tables and charts (3)
@ Printing a composite document
O Detailed Setting

"] Grayscale Printing

i 5)
@ (Preview ) ( save AsPDF... ) ( Fax.. ) ( cancel ‘| (4)
(1) Media Type Select the type of media loaded in the printer.
(2) Paper Source Select the setting here when you do not specify the paper source with the
Paper Feed Switch on the printer.
(3) Print Mode Select the type of document you want to print.
To specify more detailed settings for the print quality, click Detailed Setting.
(4) Print Click this to start printing.
(5) @ (}jick this for more information about other printer driver functions.
.?) appears also in the Page Setup dialog box.

= Note
Refer to the User s Guide for more information about printer driver functionality.
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Print Head Maintenance

60

If Blurring Occurs or If a Specific Color Does Not Print

Perform Print Head Cleaning to improve the print quality. Ensure that the printer is turned on and
follow the instructions below.

* Windows
Open the Printer Properties dialog box and click the Maintenance tab. Click Cleaning. For
details, refer to the User 5 Guide.

* Macintosh
Open the BJ Printer Utility dialog box and select Cleaning from the pop-up menu. Click
Cleaning. For details, refer to the User s Guide.

When the Printer Runs out of Ink

Replace the empty ink tank with a new one.
Specify the following ink tanks when purchasing.

Black : BCI-6BK Black : BCI-3eBK
Black

Black

BCI-6BK BCI-3eBK

Yellow : BCI-6Y 6 Magenta : BCI-6M ﬂ Cyan : BCI-6C 6
Yellow Magenta

Print Head Lock Lever 1 Open the Paper Output Tray.

Open the Top Cover and pull down the
Inner Cover, then remove the empty ink
tank.

Do not touch the Print Head Lock Lever.



Install the new ink tank.
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finished.

= Note

For more details about maintenance, refer to the

User's Guide.
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Appendix

Printing Photographs Directly from a Digital Camera

Connecting a digital still camera or camcorder to the printer allows you to print recorded images directly
without using a computer. This printer supports both PictBridge and Canon Bubble Jet Direct.

= Notes

* PictBridge is an industry standard enabling a range of digital photo solutions, including the direct
printing of photos from a digital still camera or a digital video camcorder* without the need to use
a computer.

» Canon Bubble Jet Direct allows you to print photos from a Canon Bubble Jet Direct compatible
(PictBridge incompatible) digital camera or digital video camcorder without a computer by simply
connecting the digital camera or digital video camcorder to this printer.

* Hereafter, the digital still camera and digital video camcorder are collectively called a digital

camera or camera.

B Connecting to a Digital Camera

Do not connect any equipment other than the camera ready for PictBridge or Canon Bubble Jet Direct
to the Direct Print Port of the printer. If you do so, electric shock, fire, or damage to the camera could

result.

= Notes

* When producing photos with the digital camera connected to the printer, it is advisable to use the
AC adapter supplied with the camera. If you use the camera battery, be sure to charge it fully.

* The Print Head cannot be aligned using the controls of the digital camera. For information on how
to align the Print Head from the printer, see page 51.

* Depending on the model or brand of your camera, you may have to select a mode of producing
photos compliant with PictBridge before connecting the camera.
You may also have to turn on the camera or select Play mode manually after connecting the camera
to the printer.
Perform necessary operations according to the instruction manual supplied with your camera.

» When printing from your PC, be sure to unplug the cable connecting the digital camera.

1 Turn on the printer.

Make sure the camera is turned off.

2 Load the paper in the printer.
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3 Connect the digital camera to the printer.

(1) Connect the camera to the printer using the USB cable (for connection to a computer) supplied with
the camera.

(2) Turn on and set up the camera for direct printing.
When the connection between the camera and printer has been established, the POWER lamp on
the printer flashes once.
* The power-on sequence may differ depending on the model or brand of the camera.

Either of the following icons will appear on the LCD of the digital camera display when the printer
is correctly connected.

f( A PictBridge-compliant digital camera.
D. A Canon Bubble Jet Direct compatible digital camera.

B Printing Photographs Directly from a PictBridge-Compliant
Digital Camera
Default Camera Settings

When a PictBridge-compliant camera is connected and printing is started with no printing option
selected, this printer operates based on the following default settings:

- Paper size.......ccocevuennene 10x 15cm /4" x 6"

- Paper type ..ccoceveennnnee Photo (Photo Paper Plus Glossy)
- Layout Borderless

- Trimming ........cccceeeeeene Off (No trimming)

- Image optimize ............. On (ExifPrint)

- Date print .......cccocoeneneee Off (No printing)

About the Settings Explained Below

The settings explained on the following pages cannot be made on some cameras. If any setting cannot be
made, the default setting explained above is used.

Names of settings that are displayed on Canon PictBridge-compliant cameras are used in the description
given below.

Different names may be displayed on your camera depending on the brand or model.

For details, refer to your camera’s instruction manual.
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About Paper size and Paper type

To change the paper size or paper type, operate the camera to select the PictBridge print setup
mode and confirm or check the settings.

To print on Photo Paper Pro, select Fast Photo from Paper type on the display of the camera.
Select Photo for Photo Paper Plus Glossy.

If using a Canon PictBridge-compatible camera, you can select 5" x 7" from Paper size

The following sizes and types of paper can be loaded in the printer by selecting options from
Paper size and Paper type.

Paper size setting Paper type setting Paper loaded in printer

10 x 15 cm / 4" x 6" (Default) | Photo (Default) Photo Paper Plus Glossy
Fast Photo Photo Paper Pro
Photo Photo Paper Plus Semi-gloss
Photo Glossy Photo Paper

13x18cm /5" x 7" Photo Photo Paper Plus Glossy

A4 Photo Photo Paper Plus Glossy
Fast Photo Photo Paper Pro
Photo Photo Paper Plus Semi-gloss
Photo Glossy Photo Paper

5.4 x 8.6 cm / Credit Card Photo Glossy Photo Paper

When 4" x 6" is selected from Paper size, “2-up”, “4-up”, “9-up”, and “16-up” options may be
available in Layout.

About Image optimize
If you use a Canon PictBridge-compliant camera, you can select VIVID, NR, or VIVID+NR.
(Note that these options cannot be selected for some models.)

= Notes

* When VIVID is selected, green and blue portions of photos are printed vividly.

» When NR (Noise Reduction) is selected, noise in blue portions, such as the sky, and dark
portions is removed.

* When VIVID+NR is selected, functions of both VIVID and NR are performed.




About Date print
If “On” is selected, the shooting date recorded in Exif image data is printed in the lower-right
corner of each photo.

= Notes

This printer can handle only Exif/JPEG image data to produce photos using PictBridge.
Never disconnect the USB cable during printing.

When disconnecting the USB cable between the digital camera and printer, follow the
instructions given in the Instruction Manual of the camera.

Controls of the digital camera cannot be used for the following:

- Print quality setting

- Printer maintenance

For the digital camera operation method and troubleshooting, refer to your digital camera’s
manual.

For print error messages, refer to the User s Guide.
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B Printing Photographs Directly from a
Canon Bubble Jet Direct Compatible Digital Camera

Media Types for Digital Camera
When you connect a digital camera, you can use the following media:

Digital Camera Setting Media Type
Card #1 Photo Paper Pro 4" x 6" / 101.6 x 152.4 mm
Card #2 Photo Paper Plus Glossy 4" x 6" / 101.6 x 152.4 mm

Photo Paper Plus Semi-gloss 4" x 6" / 101.6 x 152.4 mm
Glossy Photo Paper 4" x 6"/ 101.6 x 152.4 mm

Card #3 Photo Paper Plus Glossy 5" x 7"/ 127.0 x 177.8 mm
LTR Photo Paper Pro Letter size

Photo Paper Plus Glossy Letter size

Photo Paper Plus Semi-gloss Letter size

Glossy Photo Paper Letter size

A4 Photo Paper Pro A4 size

Photo Paper Plus Glossy A4 size

Photo Paper Plus Semi-gloss A4 size

Glossy Photo Paper A4 size

= Notes

* For the digital camera operation method and troubleshooting, refer to your digital camera’s manual.
* For print error messages, refer to the User s Guide.
* By operating the digital camera, you can make the following prints:
You can make a standard print from the image displayed in the single display mode or in the
index display mode.
You can print specified numbers of images, or make an index print by editing the DPOF.
For the images taken with an ExifPrint-compatible digital camera, the Photo Optimizer PRO
function can be used.
- If date printing is set from the digital camera, the date when the photograph was taken is to be
printed (excluding the index print).
Images will be scaled automatically according to the image size set on the digital camera and the
size of the media set on the printer.
* The digital camera does not support the following functions:

- Print quality setting

- Printer maintenance
* Images other than Exif may not be index printed.
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Notes on Handling the USB Interface (for Windows Users)

If installation of the printer driver does not proceed as instructed in this Setup Guide, there may be a problem
with the USB driver installation.
Try reinstalling the printer driver.

B Reinstalling

The screen shown on the left appears when the installation of

Rt the printer driver fails.
o 0o If the reinstallation is unsuccessful;
. i L ﬁ’ 1 Click Cancel on the Printer Connection
- E dialog box.
2 Click Start Over on the Installation Failure
o et e dialog box.
C ) 3 Click Back on the screen which appears
next.
4 Click Exit on the Welcome screen, then
remove the CD-ROM.
5 Turn the printer and computer off.
6 Check the cable connection.
7 Restart the computer.
8 Reinstall the printer driver (see page 16).

Printing and Initializing Network Settings

B Printing Network Setting Information

To print the current network settings of the printer, hold down the RESUME/CANCEL button
until the POWER lamp flashes 6 times, then release it.

The following information is printed.

* Printer name * Printer access control
+ Firmware version ¢ Admin password
* Wireless LAN information ¢ Device status

* Wired LAN information

This printout contains valuable information about your computer. Handle it with care.
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Initializing Network Settings

To initialize the network settings of the printer, follow these steps.

Note that initialization erases all connection settings with computers, disabling printing.

Make sure that the printer is connected to your computer with a USB

cable.
Turn on the printer.
Start BJ Network Tool.

On Windows, click Start and select All programs (or Programs), BJ Network Tool and then BJ

Network Tool.

On Macintosh, select Library - Printers - Canon - BJPrinters - Utilities - BJ Network Tool.

Select Maintenance from the Settings menu.
Click Initialize under Setting Initialization in the Maintenance dialog

box.

Click Yes in the Initialize Settings dialog box (Windows) or OK in the
Setting Initialization dialog box (Macintosh).

For Further Details...

For further information on printing operation or about the printer in general, refer to the User s Guide. For
further information on network setup, refer to the Network Guide. The guides are HTML manuals you can
browse through on your computer.
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User’s Guide Contents

* Printer parts and their functions

+ Using the sheet feeder and the cassette
* Printer driver functions

* Routine maintenance

Network Guide Contents

* Overview
* On Security
+ Changing and Confirming Network Settings

Printing media
Troubleshooting (printing related)
Specifications

Troubleshooting (network setting related)
Appendix
Glossary

How to View the User’s Guide/Network Guide

For Windows

Double-click the iP4000R User’s Guide or the
iP4000R Network Guide short-cut icon on the
desk top, or click Start and select All Programs
(or Programs), Canon PIXMA iP4000R
Manual and User’s Guide or Network Guide.

For Mac OS X

(1) Load the CD-ROM in your computer, and
double-click the OS X folder.

(2) Double-click the Manual folder.

(3) Select a language folder.

(4) Double-click the User’s Guide or the
Network Guide folder.

(5) Double-click the icon for the
iP4000R_UG_ENG.htm or the
iP4000R_NWG_ENG.htm file.



B Applications Included in the CD-ROM Package

Easy-WebPrint (Windows)

You can easily print out homepages displayed on Internet Explorer in full size without its right-
hand side being cropped. This application is automatically added to the Internet Explorer toolbar.
Internet Explorer 5.5. or later must be installed.

Easy-PhotoPrint (Windows/Macintosh)

You can make a Borderless Print easily and quickly, just by selecting a photograph taken with a
digital camera and the paper type on which to print. Also it has tools to correct red eye caused by
the camera’s flash or smooth and beatify the facial skin. It is compatible with ExifPrint.

PhotoRecord (Windows)
You can create fun and unique photo albums with a click of your mouse. It is compatible with
ExifPrint.

For more information on the applications, refer to the Photo Application Guide.

BJ Printer Driver Systems Requirements

For Windows

+ Use a computer on which Windows XP, Windows 2000, Windows Me or Windows 98 can
operate.

« USB interface

¢ CD-ROM drive

* Available hard-disk space for printer driver installation

Windows XP/Windows 2000: 50MB
Windows Me/Windows 98: 15MB

For Macintosh

» Use a Macintosh series computer equipped with USB interface on which Mac OS X v.10.2.1 or
later can operate.

* Available hard-disk space for printer driver installation

Mac OS X v.10.2.1 or later: 100 MB
+ The following functions are not supported when using Mac OS X v.10.2.1 or later:
- Manual Duplex Printing
- Poster Printing
- Fit-to-Page Printing
- Booklet Printing
- Reverse Order Printing (supported with Mac OS X v.10.3.x)
- Photo Optimizer Pro

Additional Systems Requirements for Electronic Manuals

« Pentium® 75 MHz equivalent or higher processor (Pentium® 133 MHz equivalent or higher
processor recommended)

 2x or higher CD-ROM drive (4x or higher recommended)

* 15 MB of available hard-disk space (when installing the electronic manuals)

« Windows: Microsoft® Internet Explorer 5.0 or later

« Mac OS: Microsoft® Internet Explorer 5.0 or later, Safari 1.0 or later
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Troubleshooting

Cause and measures on possible troubles in the setup procedure are explained here.

= Note
If you do not find a description for your trouble here, refer to “Troubleshooting” on the User s Guide and
the Network Guide. For details on viewing the guides, see “How to View the User’s Guide/Network Guide”
on page 68.

» The computer cannot communicate with the printer or an access point between rooms or floors,
page 71

* Cannot set up the printer, page 71

* When encryption (WEP or WPA) is enabled, the printer cannot be set up again, page 71

» The Access Points dialog box is displayed during setup, page 72

 The target access point is not detected, or you want to specify access point settings manually,
page 74

+ Cannot connect with an access point to which a WEP key is set (You forgot the WEP key), page 75

» How to set a WEP key, page 76

+ Cannot connect to the target access point, page 76

+ The Set Printer IP Address / Printer IP Address Setup dialog box is displayed during setup, page 77

* Checking the IP address or the MAC address of the printer, page 78

* Checking the IP address of the computer, page 78

* The Printer Network Setup dialog box is displayed during setup, page 79

* The printer cannot communicate with the access point in a wireless LAN, page 80

+ Cannot communicate with the printer after applying MAC address filtering or entering a WEP key to
the access point, page 80

+ No printer is detected after the network settings are changed in Windows, page 81

* The Enter Password / Password Input dialog box is displayed during setup, page 81

+ The admin password was forgotten, page 81

 Changing the port name, page 81

+ Cannot print out the network setting information, page 81

+ Using the printer in a multiple access point setup, page 81

* Re-setting the printer whose setup was canceled halfway, page 82

» Confirming the version of Windows XP, page 82
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Problem

The computer cannot
communicate with the
printer or an access
point between rooms or
floors

Possible Cause and Measures

Although wireless communication between rooms or floors is possible, the
wireless communication quality may become poor. The wall must be made of a
material that allows radio waves to pass through. If the wall material prevents
communication, set the printer in the same room as the access point.

Cannot set up the
printer

Confirm the following:

+ The USB cable is connected to the correct port.

+ The printer driver is already installed.

» The printer is turned on. If it is, turn it off and then turn it on again.

+ Printing via USB connection is possible.
If you cannot print through USB connection, see “Setting Up the Printer and
the Computer” on page 16 and connect the USB cable properly.

 The firewall feature of a security software may prevent proper setup or
communication over a network.
When setting up the printer for use over a network, disable the firewall of
your security software. Turn it back on when setup is complete.
If you are using Windows XP Service Pack 1 or earlier and you have Internet
Connection Firewall enabled, a dialog box asking you for confirmation to
disable the firewall will appear during setup. Click Yes to disable the firewall.
When setup is complete, the firewall will be re-enabled automatically.
To confirm the version of your Windows XP, see “Confirming the version of
Windows XP” on page 82.
Some network configuration programs will enable a firewall by default.
Check the settings of any such software.

+ The printer, the computer, and the access point are on the same network
segment.
Do not use the printer through a router.

+ The priority of the network to be used is set high. If not, select System
Preferences - Network and select Network Port Configurations from the
Show pop-up menu, and modify the priority of the network.

When encryption (WEP
or WPA) is enabled, the
printer cannot be set up
again

Initialize the printer’s network settings to default (see “Initializing Network
Settings” on page 68) and perform setup again with the USB cable connected.
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Problem
The Access Points
dialog box is displayed
during setup

Possible Cause and Measures
The Access Points dialog box is displayed when:

- No access point is detected.

- Multiple access points are detected.

- Entry of a network key is necessary to communicate with the target access
point.

If you connect to a network that is not protected with security measures, there is a risk of
disclosing data such as your personal information to a third party.

Follow the instructions below to detect access points.

* When no access point is detected
It may take several minutes to detect access points. For details, see “The
printer cannot communicate with the access point in a wireless LAN” on
page 80.

» When multiple access points are detected
The printer may communicate with other access points used in the vicinity.
Select the target access point, then click Connect.
You can also click Manual Setup to specify the settings of the target access
point manually on the Manual Setup dialog box.
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Accass Points

The following accrss poists ware detected
Select the access point 1o connect o, and chek [Connect]

SeciEd ACCEss POING:
Leerl  Entrystien  Access ot Name ol Crarnel
T weP Canon 5 ( 1 )

e

T Comren o) @
(3)

To conmect 16 this accrss point, enter the netwark key, and then click
[Commect].

Cuwors key [ —4)
I you rted 1 enbar the sertings manual e accass poien, elick [Manu (5)

Setw].
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Problem

The Access Points
dialog box is displayed
during setup

(Continued)

Possible Cause and Measures

(1) Detected Access Points
The signal strength, network key (WEP or WPA) usage, network name
(SSID), and the used channel are displayed.
The signal strength is indicated by the number of bars displayed with the
antenna.

“Fil :Good

T :Fair

T :Poor

Whether a network key is used or not is indicated as follows.
Blank: Not used

WEP: WEP key used

WPA: WPA key used

(2) Network Information
The Network Information dialog box is displayed to confirm network
settings when your access point or your printer cannot be detected
automatically during setup for use over the network. This button is enabled
when an access point was not detected or could not be connected.

(3) Update
Click to search for access points again when the target access point is not
detected.
Make sure that the access point is powered on.

(4) Network Key
If a password (WEP key) or a WPA key is set to the target access point,
enter the pre-shared key or the passphrase in the same format and length
as the access point. The network key can be entered when an access point
using WEP or EAP/PSK is selected.

(5) Manual Setup
Click when the target access point is not detected, or to specify settings of
the access point manually. The Manual Setup dialog box is displayed. If
your access point is using the stealth / closed network feature, specify
settings here.

(6) Connect
Connects to the selected access point.

* When an access point using WPA-802.1x (Windows) or WPA Enterprise
(Macintosh) is selected, the Connect button is grayed out and cannot be clicked.

» When an access point using WPA-PSK (Windows) or WPA Personal (Macintosh)
with type of dynamic encryption set to AES is selected, the Connect button can be
clicked but is not operable.
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Problem

The target access point
is not detected, or you

want to specify access
point settings manually

Possible Cause and Measures

If the target access point is not detected or if you want to specify access point
settings manually, click Manual Setup in the Access Points dialog box.

If you connect to a network that is not protected with security measures, there is a risk of
disclosing data such as your personal information to a third party.

[Windows|

Set the target access point and click Connect.

[ |
E,»“w} (e - Coren = r— (1)

Enter the settings for the target access point.

(1) SSID
Enter the SSID set to the access point.

SSID is also called ESS-ID. For details, refer to the manual of your access
point.

(2) Encryption Method
Select an encryption method from Do Not Use, Use WEP, or Use WPA.
When using a network key, communication is encrypted using the string you
specified. If the key has been set to the access point but not to the printer,
the setting window is displayed.

For details on WEP setting, refer to “WEP Details dialog box” on the
Network Guide. For details on WPA setting, refer to “Changing the WPA
Detailed Settings” on the Network Guide.

(3) Configuration
The detailed settings dialog box is displayed. WEP or the WPA key selected
in Encryption Method can be confirmed and changed.

(4) Connect
Connects to the specified access point.




Problem

The target access point
is not detected, or you

want to specify access
point settings manually

(Continued)

Possible Cause and Measures

Set the target access point and click Connect.

Manual Setup

Spncify the secess paint B9 onneet 1o, and then click [Connect]

G-lv.mk ESI0Y Canon )— (1 )

@c'\'plucﬂ Method: | Do Mot Use 3D— gg;
G

7 Cancel s ) ((Eeomen) ) (4)

Enter the settings for the target access point.

(1) Network (SSID)
Enter the network ID (SSID) set to the access point.

SSID is also called ESS-ID. For details, refer to the manual of your access
point.

(2) Encryption Method
Select an encryption method from Do Not Use, Use Password (WEP), or
Use WPA. When using a network key, communication is encrypted using
the string you specified. If the key has been set to the access point but not
to the printer, the setting window is displayed.
For details on WEP setting, refer to “WEP Details dialog box” on the
Network Guide. For details on WPA setting, refer to “Changing the WPA
Detailed Settings” on the Network Guide.

(3) Configuration
The detailed settings dialog box is displayed. The WEP or the WPA key
selected in Encryption Method can be confirmed and changed.

(4) Connect
Connects to the specified access point.

Cannot connect with an
access point to which a
WERP key is set (You
forgot the WEP key)

For information on how to set up the access point, refer to the manual provided
with the access point. Make sure that the computer and the access point can
communicate, then set up the printer to match the settings of the access point.
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Problem
How to set a WEP key

Possible Cause and Measures

Refer to the manual provided with the access point and check the access point
settings.

Confirm that the computer and the access point can communicate with each
other.

Then set up the printer to match the settings of the access point.

When using WEP, the key length, key format, the key to use (out of 1 to 4), and
the authentication method must match among the access point, the printer, and
the computer.

For an access point using the WEP method such as the following, use the
hexadecimal key format for the printer.

Example:

Using 64 bit key length, when the string “canon” is entered, an access point
generates the following codes.

Key 1: C9 42 28 B3 AE
Key 2: 87 CO FB 05 6B
Key 3: 9A 15 FB F8 F3
Key 4: 62 56 67 58 44

To communicate with such an access point, the key to use must be set to the
same key number as selected in the access point, and its code must be set to
the printer in hexadecimal format.

Normally, select Auto for the authentication method. If you want to specify the
method manually, select Open System or Shared Key according to the setting
of the access point.

= Note

When the AirPort Base Station is used as an access point:

+ To confirm the password (WEP key), use the AirPort Admin Utility. For details, refer to
its online help.
+ Select 64 bit if 40 bit WEP is selected for the key length in the AirPort Base Station.

Cannot connect to the
target access point

Confirm the following;

» The network name / SSID of the target access point and the printer are
identical. For information on how to set up a WEP key, see “How to set a
WEP key” on page 76.

« Infrastructure is selected as the network type.
+ If a network key is set to the access point, set the printer to match it.

» If MAC address filtering is set to the access point, register the MAC address
of the printer or disable MAC address filtering.

* The wireless channel to be used may be limited depending on wireless
network devices installed in the computer. Refer to the manual provided with
your computer or your wireless network device.

» Make sure that the channel set to the access point is valid to communicate
with the computer, confirmed above. If not, change the channel set to the
access point.

» When connecting to an AirPort Base Station, use alphanumeric characters
for the name of the network (SSID).

» Make sure that there is no barrier or obstacle between the access point and
the printer.




Problem

The Set Printer IP
Address / Printer IP
Address Setup dialog
box is displayed during
setup

Possible Cause and Measures

The following dialog box is displayed if no printer was detected on the network.
Specify an IP address to detect the target printer.

[seipimeppstns ]
e ) (1)
]7 2)
®)
T [ -i (4)

(1) Get IP address automatically
Detects the printer automatically. If automatic printer detection fails, check
the network settings and your network connection.

(2) Use next IP address
Select this check box to manually specify the IP address for the printer to
detect.

IP Address/Subnet Mask/Default Gateway

Enter each value to specify a fixed IP address when Use next IP Address
is selected.

(3) Network Information
The Network Information dialog box is displayed to confirm network
settings when your access point or your printer cannot be detected
automatically during setup for use over the network. This button is enabled
when an access point was not detected or could not be connected.

(4) Connect
Searches for the printer with the specified settings.

Prister IP Addeess Setup

The printer in the retwsek could net be deected sstomatically,
Set the I address of the printer 1o be used.

TCR/W Satting Gt 1P address automatically

(1)
et o (2)
? G Com (3)

(1) TCP/IP Setting
Select Get IP address automatically or Use next IP address. Select Get
IP address automatically to search for the target printer automatically. If it
fails, check the network settings and the network connection.

IP Address/Subnet Mask/Router

Enter each value to specify a fixed IP address when Use next IP address
is selected.

(2) Network Information
The Network Information dialog box is displayed to confirm network
settings when your access point or your printer cannot be detected
automatically during setup for use over the network. This button is enabled
when an access point was not detected or could not be connected.

(3) Connect
Searches for the printer with the specified settings.
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Problem

Checking the IP
address or the MAC
address of the printer

Possible Cause and Measures

To check the IP address or the MAC address of the printer, print out the printer
setup information or use BJ Network Tool.

For information on how to print out the printer network setting information,
“Printing and Initializing Network Settings” on page 67.

To display the Network Information dialog box, in the BJ Network Tool, select
Network Information from the View menu.

Checking the IP
address of the
computer

To check the IP address assigned to the computer, follow the procedure below.
W
* When using Windows XP/Windows 2000

1 From the Start menu, select (All) Programs, Accessories, and then
Command Prompt.

2 Enter “ipconfig” and press the Enter key. The IP addresses of the
network devices installed in your computer are displayed.

* When using Windows Me/Windows 98

1 From the Start menu, select Run.

2 Enter “winipcfg” in the Name text box and click OK.
Select the network device to display the IP address.

1 From the Apple menu, select System Preferences, and then Network.
2 From the Show pop-up menu, select the interface to use.

° Important
Select AirPort when using wireless LAN.

3 Select the TCP/IP tab.
The currently assigned IP address is displayed.




Problem

The Printer Network
Setup dialog box is
displayed during setup

Possible Cause and Measures
The Printer Network Setup dialog box is displayed in the following cases.

- when you are re-setting a printer whose setup was canceled halfway

- when you changed the network settings

- when you are already using a printer over a wireless LAN

If you canceled setup or changed the network settings, perform network setup
again.

[Windows |

Printor Matwork Setup %

I
otz ot o chh, est],

(= ) Ermm - 2)

(1) Change printer setting and then execute LAN connection
The printer network settings will be changed to enable communication
under the current network settings.

(2) Execute setup without changing printer settings
Continues computer setup with the settings specified to the printer.

Select this when you are not currently connected to a network but want to
set up the computer with the settings specified to the printer.

= Note

After setup, confirm that the printer and the computer (or the access point, when using
wireless LAN) can communicate with each other. If not, perform network setup again.

Printer Network Setup

e printer may not communicate with the computer with its correst LAN

er sestings so that communication is possible under the current
nt

wup without changing the printer settings, select [Execute setup
stes sattings] and then elick [OK]

s~ o
=/ =7
Set up withowt changing the (G Change prisser settings and then 1
peinr settings ® cxncute LN connection

7 | Cancel ) (T o0 ) (2)

(1) Change printer settings and then execute LAN connection
The printer network settings will be changed to enable communication
under the current network settings.

(2) Set up without changing the printer settings
Continues computer setup with the settings specified to the printer.
Select this when you are not currently connected to a wireless LAN but
want to set up the computer with the settings specified to the printer.

= Note

After setup, confirm that the printer and the computer (or the access point, when using
wireless LAN) can communicate with each other. If not, perform network setup again.
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Problem

The printer cannot
communicate with the
access pointin a
wireless LAN

Possible Cause and Measures

1 Click Update to search for access points again from the Access Points
dialog box.

2 If the access point is still not detected, move the printer closer to the

access point or remove any obstacles, and then click Update.

3 If the access point is still not detected, click Manual Setup to specify
the settings of the access point in the Manual Setup dialog box, and
then click Connect.

4 Make sure that the computer and the access point can communicate
with each other. For details, see “Checking if the computer and the
printer (access point) can communicate with each other” on the
Network Guide.

5 Disconnect the power cord of the access point, plug in the cord again,
and then click Update.

* Access point settings
For information on how to modify the settings of the access point, see
the manual provided with the access point.
When MAC address filtering is set to the access point, register the
MAC address of the printer or disable MAC address filtering.
When the access point does not permit SSID broadcasting, or if the
stealth function / closed network is enabled, enter the network name
(SSID), etc, to the printer manually.
When an SSID or a network key is set to the access point, enter the
identical SSID or network key as those set to the access point. SSID
is case-sensitive.
For information on how to set WEP, see “How to set a WEP key” on
page 76.

* Wireless channels
Computers with a built-in wireless network card may restrict the
wireless channels it can use. Check the channel available to the
wireless network card. For information on how to check wireless
channel, see the manual provided with the computer or the wireless
network card.
Make sure that the wireless channel the access point is using is one
that the computer supports. If not, change the wireless channel set to
the access point to one supported by the computer.

¢ Location

Make sure that there is no barrier or obstacle between the access
point and the printer.

Cannot communicate
with the printer after
applying MAC address
filtering or entering a
WEP key to the access
point

- Refer to the manual provided with the access point to confirm the access

point setting. Make sure that the computer and the access point can
communicate with each other under this setting.

If you are performing MAC address filtering at the access point, confirm that
the MAC addresses for both the computer and the printer are registered.

- If you are using a WEP key, make sure that the key for the computer and the

printer matches that set to the access point.

- Besides the WEP key itself, the key length, key format, the key ID to use, and

the authentication method must match among the printer, the access point,
and the computer.

- Normally, select Auto for the authentication method. If you want to specify

the method manually, select Open System or Shared Key according to the
setting of the access point.




Problem

No printer is detected
after the network
settings are changed in
Windows

Possible Cause and Measures

Wait until the IP address is assigned to the computer. You may need to restart
your computer. When you are using Windows Me or Windows 98, you need to
restart the computer. Search for the printer again after confirming a valid IP
address is assigned to the computer.

The Enter Password /
Password Input dialog
box is displayed during
setup

The following dialog box is displayed if an administrator password is set to the
printer which has already been set up.

[Windows |
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Admin Password

Enter the administrator password you have set. The administrator password
consists of alphanumeric characters and is no longer than 32 characters. The
password is case-sensitive.

For security, your entry will be displayed by
(bullets) for Macintosh.

ik “gn

(asterisks) for Windows and

The admin password
was forgotten

Restore the printer setting to factory default. All settings previously set will be
lost after initialization. Set up the printer again to use it. For details, see
“Printing and Initializing Network Settings” on page 67.

Changing the port
name

To change the port name, click Set Port Name in the Add Port dialog box.

The Set Port Name dialog box is displayed, where you specify the port name.
When you have 2 or more printers, you may want to change the port name for
identification.

Boshiome. O (TEHSTIN

[T |__Concel Hels

Port Name

Port names should consist of alphanumeric characters and be no longer than
24 characters (12 characters under Windows Me or Windows 98), excluding

the prefix. The port name includes the fixed prefix “CNBJNP_", which you do
not need to enter.

Cannot print out the
network setting
information

See “Printing and Initializing Network Settings” on page 67 to print out printer
setting information. If it fails, use BJ Network Tool or Network Configuration to
confirm the network settings from the computer.

Using the printer in a
multiple access point
setup

Confirm the following;

» The access point to be used can communicate with the printer and the
computer.

» Under Windows XP, the priority of the access point is set to highest in the
Preferred networks list displayed by clicking the Wireless Networks tab in
the Wireless Network Connection Properties dialog box.

» The wireless channel of the access point is far enough away with those of

other access points.
For more information, see the manual provided with the access point.
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Problem

Re-setting the printer
whose setup was
canceled halfway

Possible Cause and Measures

Restore the printer to the factory settings and set up the printer again. For
details, see “Printing and Initializing Network Settings” on page 67. For setup
procedures, see “Setting Up the Printer and the Computer” on page 16.

Confirming the version
of Windows XP

If you are using Windows XP, you may need to confirm your system version to
configure the network setting of your computer.

To check the version of Windows XP, follow these steps.

1 Right click My Computer from the Start menu and select Properties.
System Properties will be displayed.

2 Confirm that the General tab is displayed.

3 Confirm your Windows XP version under System.




Conformity declaration for R&TTE

C€05600®

English

Hereby, Canon, declares that this PIXMA iP4000R is in compliance
with the essential requirements and other relevant provisions of
Directive 1999/5/EC.

Finnish

Canon vakuuttaa taten ettd PIXMA iP4000R tyyppinen laite on
direktiivin 1999/5/EY oleellisten vaatimusten ja sité koskevien
direktiivin muiden ehtojen mukainen.

Dutch

Hierbij verklaart Canon dat het toestel PIXMA iP4000R in
overeenstemming is met de essentiéle eisen en de andere relevante
bepalingen van richtlijn 1999/5/EG

Bij deze verklaart Canon dat deze PIXMA iP4000R voldoet aan de
essentiéle eisen en aan de overige relevante bepalingen van
Richtlijn 1999/5/EC.

French

Par la présente Canon déclare que I'appareil PIXMA iP4000R est
conforme aux exigences essentielles et aux autres dispositions
pertinentes de la directive 1999/5/CE

Par la présente, Canon déclare que ce PIXMA iP4000R est
conforme aux exigences essentielles et aux autres dispositions de la
directive 1999/5/CE qui lui sont applicables

Swedish

Harmed intygar Canon att denna PIXMA iP4000R star |
Overensstdmmelse med de vasentliga egenskapskrav och 6vriga
relevanta bestammelser som framgar av direktiv 1999/5/EG.

Danish

Undertegnede Canon erkleerer herved, at falgende udstyr PIXMA
iP4000R overholder de vaesentlige krav og gvrige relevante krav i
direktiv 1999/5/EF

German

Hiermit erklart Canon, dass sich dieser/diese/dieses PIXMA
iP4000R in Ubereinstimmung mit den grundlegenden
Anforderungen und den anderen relevanten Vorschriften der
Richtlinie 1999/5/EG befindet". (BMWi)

Hiermit erklért Canon die Ubereinstimmung des Gerates PIXMA
iP4000R mit den grundlegenden Anforderungen und den anderen
relevanten Festlegungen der Richtlinie 1999/5/EG. (Wien)
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Greek

ME THN MAPOYZA Canon AHAQNEI OTI PIXMA iP4000R

ZYMMOP®QNETAI NPOZ TIZ OYZIQAEIZ AMAITHZEIZ KAl
TIZ AOINEZ IXETIKEE AIATAZEIZ THZ OAHTIIAL 1999/5/EK

Italian Con la presente Canon dichiara che questo PIXMA iP4000R &
conforme ai requisiti essenziali ed alle altre disposizioni pertinenti
stabilite dalla direttiva 1999/5/CE.

Spanish Por medio de la presente Canon declara que el PIXMA iP4000R
cumple con los requisitos esenciales y cualesquiera otras
disposiciones aplicables o exigibles de la Directiva 1999/5/CE

Portuguese Canon declara que este PIXMA iP4000R esta conforme com os
requisitos essenciais e outras disposi¢des da Directiva 1999/5/CE.

Malti

Hawnhekk, Canon, jiddikjara li dan PIXMA iP4000R jikkonforma
mal-htigijiet essenzjali u ma provvedimenti ohrajn relevanti li hemm
fid-Dirrettiva 1999/5/EC
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Regulatory Information

I For 110-120V, 50/60Hz model
Color Printer Model: K10245 (Contains IC 498C-K30242)

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two
conditions: (1) This device may not cause harmful interference, and (2) this device must accept any
interference received, including interference that may cause undesired operation.

Note: This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference in a residential installation. This equipment generates, uses and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio communications.

However, there is no guarantee that interference will not occur in a particular installation. If this
equipment does cause harmful interference to radio or television reception, which can be determined by
turning the equipment off and on, the user is encouraged to try to correct the interference by one or more
of the following measures:

B Reorient or relocate the receiving antenna.

B Increase the separation between the equipment and receiver.

B Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
B Consult the dealer or an experienced radio/TV technician for help.

Use of a shielded cable is required to comply with Class B limits in Subpart B of Part 15 of the FCC
Rules.

Do not make any changes or modifications to the equipment unless otherwise specified in the manual. If
such changes or modifications should be made, you could be required to stop operation of the equipment.

Canon U.S.A., Inc.

One Canon Plaza

Lake Success, NY 11042
1-516-328-5600



The following ink tanks are compatible with iP4000R.
For details on ink tank replacement, refer to “Print Head Maintenance” in this guide.
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Yellow Magenta
BCI-6BK BCI-3eBK BCI-6Y BCI-6M BCI-6C

QAT7-3430-V02 XXXXXXXX ©CANON INC.2004 PRINTED IN THAILAND





